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IMPORTANT.
For our UK customers, service under guarantee is offered solely by the CASELLA CEL Limited service
department. There are no UK agents or repair services authorised by us to carryout this work.

In order to ensure that only approved replacement parts are used for routine maintenance after the guarantee
period, we recommend that this is carried out by our fully skilled service engineers or in the case of service
required outside the UK. by our appointed agents.
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USER MANUAL

HEAT STRESS MONITOR

COPYRIGHT

The copyright in this document which contains proprietary information is vested in CASELLA CEL
LIMITED.  The contents of this document must not be used for purposes other than for which it has been
supplied or reproduced or disclosed wholly or in part without the prior written permission of CASELLA
CEL LIMITED.

CASELLA CEL LIMITED
Regent House
Wolseley Road
Kempston
Bedford
MK42 7JY
Telephone: +44 (0)1234 844100
Facsimile: +44 (0)1234 841490
E-Mail: info@casella.co.uk
Webpage: http://www.casella.co.uk
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CASELLA 'HEAT STRESS MONITOR' SOFTWARE FOR

WINDOWS

The Heat Stress monitor software package is a powerful and versatile program for the accumulation,
processing and presentation of heat stress data.

The program integrates the functions of real time data presentation, data archiving and historical analysis
within one attractive and easy to use package.

The program operates within the WINDOWS environment and provides the following features:-

• A real time display indicating prevailing heat stress conditions and trends.
• Archiving of data to disk at a user defined interval for historical analysis.
• Dynamically changing screens including scrolling graphs and alarm warnings
• Production of line graphs based upon historical data.
• Tabular report presentation of data files.
• Automatic calculation of derived values including Humidity, Vapour Pressure, and Dew Point.
• Real time display pages may be user configured to meet specific display requirements.

1.0 HARDWARE REQUIREMENTS

IBM Compatible P.C. 386 SX upwards
4MB Memory. Mouse, Spare RS232 Serial Port.
VGA or SVGA monitor. Program occupies less than 2MB.disk space.
Windows Operating System: Ver 3.1, 3.11 for Work Groups, Windows 95, NT.

2.0 PROGRAM INSTALLATION

The software will be supplied on one 3.5" floppy diskette. Insert the disk into the floppy drive.

Using windows file manager, initiate the file INSTALL.EXE. Follow on screen messages to load the
program into the desired directory (e.g. C:\HSM)

Following installation, it may be necessary to adjust certain parameters such as the serial port
identification to suit the hardware environment.
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3.0 CONNECTING THE HSM100 TO A  P.C.

The HSM 100 should be connected to a spare RS232 serial port on the P.C using the supplied cable.
Please ensure that the selected port is not used for other applications and that no device drivers are loaded
which may conflict with the ports use (DOS Mouse drivers, modem software etc.)

For information, the HSM100's data socket is wired as follows;

HSM CONNECTOR  IBM 9 WAY FEMALE
1 TXD 2 RXD
2 DTR 1 DCD, 6 DSR, 8 CTS
3 GND 5 GND
4 RTS 4 DTR

Data will be transmitted from the HSM100 every 1-2 seconds whilst it's RTS line (Pin4) remains high.

4.0 STARTING THE PROGRAM

To initiate the 'HSM' software, double-click the 'HSM 100' Icon within the 'HSM for WINDOWS'
program group.

All menus and options are accessible using mouse based operations. If you are new to the Graphical user
interface of the Windows environment, please refer to your Microsoft Windows documentation.

5.0 PROGRAM CONFIGURATION

Program set-up details defining the screen layout, data parameters and serial port connection are saved
within a file HSM.INI. To prevent unauthorised operators modifying the software's configuration and
thereby introducing potential problems, it is recommended that the 'HSM.INI' file is made 'read-only'.
Whilst this file is in a read only condition, all menu options used to access editing functions are removed
from menus. The read only attribute may be set from Windows `File Manager' or `Explorer'.

6.0 USING HELP

The program has been written such that the user should find the application both quick to learn and easy
to use. As with all new software packages the user should spend some time experimenting and becoming
familiar with menu functions. A 'Help' 'Contents' window provides a list of all major Help topics.

7.0 SERIAL PORT SELECTION

The program will be supplied configured to expect the HSM 100 to be connected to the P.Cs 'COM1'
serial port. The serial communication port settings can be changed by using the 'Edit Data Input',
'Properties', option from the main 'Options' menu. The HSM 100 communicates at 1200 Baud, with 8
Data bits, no parity, one stop bit and no flow control.

Save any set-up changes such as the serial port details using the 'Save Configuration' option from within
the 'Options' menu.

8.0 CUSTOMISED SCREEN LAYOUTS. (FOR SPECIALISED APPLICATIONS)
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The program is supplied ready to operate with 4 display pages pre-configured to suit the vast majority of
applications. Many customers may not find it necessary to customise the screen configuration. A copy of
the original program diskette should be retained such that it is possible to re-load the program with its
default configuration files.

The currently displayed page is selected from the 'View' menu.

A maximum of 8 different screen configurations may be customised to suit a specific requirement.
Display pages may incorporate a variety of display elements including value boxes, scrolling graphs, text
messages and bit map images for the display of company logos etc.

Modification to the programs display configuration can only be carried out whilst the file 'HSM.INI' is in
a Read/Write mode. Use Windows 'File Manager' or `Explorer' to change the properties of the supplied
file from read only to read-write and then start the HSM program.

Simple mouse based operations enable display elements to be added, positioned, sized or deleted. To
modify any on screen display elements including positions, sizes, titles, data channels, display units etc.,
either 'Click the right mouse button' or select 'Edit Display' from the 'Options' menu.

9.0 SIZE     AND POSITION   

The 'Size' and 'Position' functions are self explanatory. Simply click and hold the left mouse button whilst
located on the relevant display element and move the mouse to reposition or size the element. Release the
mouse button to complete the operation.

10.0 MODIFY PARAMETERS   

The 'Modify Parameters' option is used to edit various characteristics of a display element.
Position the marker on the relevant box and click the left button. Text items including titles,
engineering units, fonts, borders and colours may be changed within the 'Edit Basic Parameters'
window. The 'Data' channel identifies which input data field will be presented within the display
element.

11.0 DELETING    DISPLAY ELEMENTS

To delete a display element, simply position the cursor marker on the relevant display item and
click the left mouse button. NOTE: Once an element has been removed and the new
configuration saved, there is no way of recovering a deleted object.

12.0 ADDING    NEW DISPLAY ELEMENTS

The following display elements are available for presentation on a real time screen;-
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12.1 Text box
Used to display a fixed text message as shown below:-

12.2 Date box / Time box
Use to display Time and Date based on the P.Cs internal clock.

12.3 Value box
Use to display a data channel value together with top and bottom labels as shown below.

12.4 Bitmap box
Used to display a 16 Colour windows bitmap image file. Commonly used to display 
company logos, site maps, warning symbols etc.

12.5 Multistate box
Multi-state images are created using a single bit map which is subdivided horizontally into blocks
of equal width. The displayed image section is dependent upon the value of a data channel. e.g.

In the battery condition example above;- the number of images should be set to 2. The 'steps'
value is set to 0.5. The 'Battery Low' image will be displayed for values less than or equal to 0.5,
the 'Battery O.K' image will be shown for values above 0.5. The battery status value contained
within the HSM100 message is 'L' for a Low discharged battery and 'H' for a good High battery.
The software automatically converts the letter 'H' to a value 1 and the letter 'L' to a value 0.
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12.6 Graph box
Provides a real time scrolling graph for one or two traces over a user selectable time period.

The trace dimensions box contains values to set up the position and size of the trace area in
relation to the outer box.

TRACE DIMENSIONS

In this example, the trace area starts 35 pixels to the right of the top left hand corner of the
element window and 40 pixels down. The trace area is 400 pixels wide and 360 high.

13.0 SCROLLING DISPLAY FEATURE

The Heat Stress software provides up to 8 separate display pages. Each page may be selected for display
from the 'View' pull down menu.

The 'Scroll' option allows the software to automatically display the pages in any sequence with a
programmable delay between each page.

To enable the scroll mode, select 'Scroll setup' from the 'Options' pull down menu. Click on the Enable
box to enable or disable the automatic scrolling and enter the sequence in which you want the pages to
appear in the 'Order' box.

The default time delay is fifteen seconds, however this can be changed by editing the [Scroll] section of
the HSM.INI file.

[Scroll]
Enable=Yes
Order=1,2,3,4,
Interval=15

This will give a time delay of 15 seconds. Note that the scroll mode enable/disable and page order may
also be changed here.

 35,40,400,360
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14.0 SAVING THE CONFIGURATION

Any modifications or additions to the programs configuration should be saved using the 'Save
Configuration' option from within the 'Options' menu. The file 'HSM.INI ' can be made Read-Only once
you are happy with the programs configuration.

To return to display mode, either press the right mouse button and select the 'Return to Display Mode'
option, alternatively, select 'Display Mode' from the 'Options', 'Edit Display' menu.

15.0 GRAPH AND TABULAR DATA PRESENTATION

Historical graphs and tables are created using the 'Historical Table' or 'Historical Graph' options from the
'View' menu. All presentations utilise data files saved using the HSM software.

All presentations require selection of the required start date and times. Graphs may be used to display two
different traces, the extreme values of the 'Y' axis ranges may be determined via the 'Options' 'Edit
Graph Scales' menu or alternatively by using the 'Edit Trace' option when selecting the trace(s) to be
plotted.

All presentation formats can be printed using the 'Print Window' option within the 'File' menu.

Data files are automatically saved as daily files using a comma separated text format which may be easily
imported into many commercial spreadsheet, data base or word processing applications.

16.0 ALARMS

The Heat Stress Monitor software incorporates an ALARM facility. Any or all of the sensor channels can
be used to initiate an alarm upon reaching a pre-set value.

An alarm is indicated by the appropriate value box flashing red and an audible bleep from the P.C. The
title bar of the window will also flash.

16.1 Setting the upper & lower alarm limits

Click on Options and from the pull down menu select Edit Data Input.
From the sub-menu select Processed Data.
Note the Channel ID Code area and click on the Current ID button. Chose the sensor you wish to 
set from the displayed list.
The current alarm settings for that sensor will appear in the Alarms area. Change the Upper
Alarm Limit and Lower Alarm Limit values as desired.
After you have entered the new value, click on the Save Changes button. You may now select 
another sensor to change or click on Done to exit. Click on Options again and select Save 
Configuration to save the changes you have made.
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16.2 External alarm operation.

When an alarm condition exists, the DTR line of the comms port will go high and may be used to
switch an external alarm using a suitable interface circuit. The comms port for the alarm may, or
may not be the same one you are using for communications with the HSM100. Any serial port can
be selected for the alarm output by editing the [ALARM] section of the 'HSM.INI' file.

[Alarm]
Enable=No
Port=Com1:,9600,N,8,1
DataLossEnable=Yes
DataLossInterval=60
ActiveHigh=Yes

This will cause the DTR line of serial port 1 to go high if an alarm condition exists.

The external alarm will operate for about two seconds when the 'HSM' software is first initiated. 
After this, a manual test may be carried out by selecting the 'Options' - 'Alarm' - 'Test' option.
Other alarm functions available include;-

Mute:- silences alarm but leaves the relevant display boxes flashing.
Reset:- Cancels the alarm or 'test' function.

16.3 Loss of Data Alarm

A time out period for incoming raw data may be defined by editing the '[Alarm]' section of the
HSM.INI file. If the normal alarm function is disabled then so is the Loss of data alarm. The
time-out interval is expressed in seconds.

When the loss of data alarm is triggered all data elements and also the title bar at the top of the 
screen will flash.

17.0 DATA LOGGING / COLLECTION.

The software can be used to automatically log data to the hard disk during program execution. Logging
can be turned on and off via the 'Options' - 'Logging' menu.

The path used to save and retrieve data files is specified within the 'HSM.INI' file;-

[Logging]
Path=C:\HSM\
Enable=Yes
Interval=10
Units=Minutes
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18.0 DATA INPUTS AND PROCESSED DATA.

The defining of data inputs and processed data channels represents the most complex aspect of the 'HSM'
software package. Most users should have no need to edit or modify any of the data definitions. The
program will be supplied with all data inputs pre-configured to suit the HSM100 output message. Vapour
pressure, dew point and humidity values are also calculated. Under normal circumstances it should not be
necessary to modify any of the data definitions. The primary data input from the HSM100 is defined
within the 'Edit Data Input'  'Device' 'Channels' window. The Data inputs represent the sequence of data
values contained within the HSM100 message. The serial data message transmitted by the HSM100 is
shown below;-

I,+021.5,+021.5,+028.7,+018.4,+028.7,M,+025.3,+025.2,+030.3,+022.7,+031.7,C,2,H

I,+021.5,+021.5,+028.7,+018.4,+028.7,M,+025.3,+025.2,+030.3,+022.7,+031.7,C,2,H

The comma separated values represent the following parameters;-

I Instant values next
+021.5 Indoor WBGT
+021.5 Outside WBGT
+028.7 Dry Temp
+018.4 Wet Temp
+028.7 Globe Temp
M Max values next
+025.3 Max Indoor WBGT
+0225.2 Max Outside WBGT
+030.3 Max Dry Temp
+022.7 Max Wet Temp
+031.7 Max Globe Temp
C Degrees C used (F for Fahrenheit)
2 Globe Size
H Battery State (H=High, L=Low)

Data obtained from the raw input 'Channels' is passed into 'Processed data' channels. Processed data
channels are used to define the acceptable range of the data, high and low alarm thresholds, the data
format (number of decimal places), logging units and also to provide various mathematical functions.

Functions include:-

EXTREME ([MAX/MIN])

Retains the maximum or minimum data value since reset or midnight.

Reset the extreme values using the 'Reset Parameter'   command from the 'Options' menu.

VAPOUR(HUMIDITY)
Calculates the Vapour pressure (hPa) based upon a data source containing the Temperature (°C)

and the Humidity (%RH) value.
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DEWPOINT()
Calculates the DEW point temperature based upon a Data source of Vapour Pressure.

HUMIDITY(WET,V,P)
Calculates a Humidity value based upon a data source of 'Dry' bulb Temperature, a 'Wet' bulb 
temperature, Ventilation and a Pressure constants. The 'Scale' function is used to set the 
Ventilation constant to 0.000696 and the Pressure constant to 1000mBar.

DEGREEDAY(THRESHOLD,[ABOVE/BELOW])
An integrating function used to calculate 'Degree Day' values. For Degree day measurement the 
input data source would be a temperature value. The Temperature difference above or below the 
'Threshold' is integrated with respect to time.(ie, if the temperature is 2°C above threshold for 12 
hours (half a day) then the result would be 1 degree-day.

ROLLAVG(SECONDS)
Calculates the rolling average of the data input occurring over a 'Seconds' time period.

SCALE (M, C)
Provides linear scaling of the input data source values according to the equation :-
Processed Data =Mx+C.  where  ' X'  is the specified 'Data input' channel.
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APPENDIX A - FORMULAE.

The following formulae are used to derive Humidity and Dew point values based upon measured wet and
dry temperatures (Tw and Td).

The saturated vapour pressures are calculated using the MAGNUS formula (Ref. BS1339:1981-
Definitions, formulae and constants relating to the humidity of air)

Where:
ew is the saturation vapour pressure of the air (hPa).

Tw is the air temperature  (°C).

The remaining constants can have different values depending on the temperature of the wet sensor. If the
sensor is below 0°C then it is deemed to be 'Over Ice' else 'Over Water'. The following constants are
automatically selected by the program during operation:

Over Water Over Ice
G 7.5 9.5
H 237.3 265.5
I 0.78571 0.78571

The actual Vapour pressure (Regnault and August and Apjohn) is calculated as;-

e =  e  -  A P(td - tw)s( w ) ×

Where es(w) is the saturated vapour pressure based on the wet bulb temperature(calculated using the
Magnus formular), 'A' is the Ventilation constant and is chosen to suit the instrument type and ventilation
rate of the wet sensor. A=7.99x10-4 is appropriate to a ventilation rate of 1-1.5m/S assuming the wet bulb
>0°.(Ref: MET.O.265b Hygrometric Tables)
'P' is the air pressure measured in mBar, usually this is considered to be a mean value of 1000mB.

Humidity is calculated according to;-

Where 'e' is the vapour pressure and 'es(t)' is the saturated vapour pressure calculated using the Magnus
equation for the dry bulb temperature.

Dew Point;
The Magnus formula is used to evaluate the dew point temperature assuming a saturated vapour pressure
equal to the actual vapour pressure;-

Dew Pt C =  
[Log10 (Vapour)  237.3] -  186.44898

[8.2857 -  Log10 (Vapour)]
 ° ×

WBGT CALCULATION

log e  =  
GT

H +  T
 +  I10 w

w

w

RH%  =  
e

e
   100

s( t )

×

log e  =  
GT

H +  T
 +  I10 w

dew

dew
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The WBGT values are calculated within the HSM 100 instrument. They are based upon the
following equations-(Ref ISO 7243).

WBGT  =  0.7 Wet +  0.3 GlobeInside × ×

WBGT  =  0.7 Wet +  0.2 Globe 0.1 DryOutside  +    × × ×
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